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1 Introduction
As a field sales representative, you are often out of the office working with 
prospects and customers on sales opportunities and customer issues. It is 
important for you to be well-informed of the activities and issues of each 
customer with which you meet. Oracle provides Oracle Sales Offline to help 
you manage your work while away from the office.

Sales Offline is a mobile application that imports and exports 
(synchronizes) information from an Oracle enterprise database. This 
application enables you to view and/or update your sales information 
remotely via your laptop computer. 

This guide describes how to setup and use Sales Offline, and contains these 
topics:

� Getting Started

� Navigating within Sales Offline

� Synchronizing Data

� Conflict Resolution

� Tasks

� Lead
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� Opportunity

� Quote

� Forecast

� Customer

� Implementing Sales Offline

2 Getting Started
This section describes how to download Sales Offline and includes 
troubleshooting tips for the download.

2.1 Downloading the Sales Offline Application
If you are a first-time-user, you must download Sales Offline from Oracle 
Sales Online before proceeding.

To download Sales Offline:

1. Login to Oracle Sales Online.

2. Click the Mobile tab. 

3. Create a new folder in your directory.

4. Download Sales Offline by clicking the Download Sales Offline 
Template link. 

5. Navigate to the downloaded file SalesOffline.zip in your directory. 

6. Unzip the file into your folder.

7. Run Sales Offline by double-clicking the file SalesOffline.xls.   

8. Enable macros when prompted.

9. Click the Sync icon.

10. Enter the requested user information and then click Sync. The 
synchronization preferences will display the first time you Sync.

11. Enter the download criteria by choosing either the Sales Team Driven 
download or Forecast Driven download. 

The Sales Team Driven download will result in records based on your 
sales team access. If you are on the sales team of an Oracle business 

Note: If you are a DBA or the technical administrator, please 
complete the procedure in "Implementing Sales Offline" before 
continuing.
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object (for example, organization, lead, or opportunity) these records 
will be downloaded to Sales Offline. 

The Forecast Driven download of data is based on the opportunities 
that are open within the forecast range selected. Customer 
organizations and contacts that are associated with the opportunities 
are downloaded. 

You can further filter your data using the Sync preference filters. These 
preferences can be saved for use in future synchronizations. The Sync 
preference filters:

� Lead Preferences - can be filtered by Status, Channel, Lead Rank, 
Budget Status, Time Frame, or Number of Records

� Opportunity Preferences - can be filtered by Status, Sales Stage, 
Sales Channel, Win Probability (from/to)

� Quote Preferences - can be filtered by Inventory Category Set 
(Default Category Set, or the Sales and Marketing Category Set), 
Inventory Category, Price List

� Forecast Preferences - can be filtered by Period Type, Category, 
Start Period and End Period, Credit Type

� Organization Preferences - can be filtered by Customer Category, 
Country, State

2.2 Troubleshooting Tips
This section describes the most common problems that can occur when 
attempting to download Sales Offline.

2.2.1 Sales Offline Fails at the Macros
If Sales Offline fails at the macros, check to ensure that the macros security 
is set at medium or low level. You can do this by navigating to Tools > 
Macro > Security in Excel 2000.

Note: You must select items (from the Default Category Set, the 
Sales and Marketing Category Set, or the Price List) for download. 
You can select items from multiple categories. Multiple items can be 
selected by highlighting a row and using the Ctrl or Shift functions.
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3 Navigating within Sales Offline
In Sales Offline, tabs indicate the first layer of information and subtabs 
show further details. Links enable you to access detailed information about 
specific items.

The following table describes navigation features and fields:

4 Synchronizing Data
The Sales Offline synchronization process uploads changes or additions to 
the server and downloads changed or added records back to the laptop. 
You do not have to login to Oracle Sales Online to upload and download 
data. The sync function handles this process within the application.

Complete the following steps to synchronize data:

1. In Sales Offline, click the Sync icon.

2. Enter the proper information in any blank fields.

3. Click Sync to start the synchronization process. A status bar will appear 
giving you information on the synchronization progress. 

4. You will receive a message at the end of the synchronization process 
informing you that the synchronization was successful or if there were 
errors. 

Item How it works

Tab Enable you to navigate among the areas of 
functionality in the application.

Subtab Enable you to access further functionality under a 
tab.

Link or hyperlink Enable you to navigate to further levels of detail 
under the subtab.

Asterisks Designate required fields. These fields have a 
white background. Fields with a white background 
and no asterisk are optional. Fields with a grey 
background are read-only. 

Column headings Enable you to sort rows of information. Clicking 
on a column heading will sort rows in ascending or 
descending order based on the information in the 
selected column.

Go button Enables searches for a list of values. 

Ctrl F Enables you to search for a specific value.
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a. If you receive conflict errors (usually noted as a stale data message), 
navigate to the Home tab and click the Conflict Resolution subtab 
to resolve the conflicts in the Conflict Resolution screens (see 
"Conflict Resolution").

b. If you receive a server not found and not available error, please 
contact your administrator for assistance.

4.1 Changing Data Download Criteria
Follow these steps if you want to change the data download preference 
criteria:

1. In Sales Offline, click the Profile icon.

2. Update appropriate information.

3. Click Save to save changes or Sync to start the synchronization process 
(which will save changes on completion).

5 Home Tab
The Home tab is the first screen you see when you invoke Sales Offline. The 
Home tab lists new items or items that have changed since the last time 
Sales Offline was synchronized. 

Initially, the Home tab will show no records listed. New or changed items 
will be listed as the result of subsequent synchronizations. Records will be 
listed in the appropriate tables, depending on the source of the record. You 
can click on the hyperlink for the listed record to learn more about it. 

6 Conflict Resolution
Using a remote application that synchronizes information with a master 
database can result in data conflicts. Conflict resolution is critical to using a 
remote application successfully, and it is important that up-to-date and 
accurate information is written to the master database. It is important to 
note that the server record will always override your Sales Offline client 
record. If the same server and client record has been changed in between 
synchronization processes, a conflict will occur, and the server record will 
override your client record. The conflict can be resolved in the Home tab, 
using the Conflict Resolution subtab.

To resolve conflicts between the Oracle Sales Online database and Sales 
Offline:

1. Open Sales Offline.

2. Click the Conflict Resolution subtab in the Home tab.
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3. In the Conflict Resolution screen, you will see tables of conflicts that 
occurred during synchronization. 

4. Click the link to see details of the conflicted record and make the 
necessary updates before deciding to apply the changes or discard 
them.

On the left side of the form is your local Sales Offline record. On the 
right side of the form is the Oracle Sales Online server record. The fields 
that caused the conflict are shown in red. 

If you choose Reapply, the Sales Offline record will override the Oracle 
Sales Online record. You must perform a synchronization for your 
record to be applied to the database. If you choose Discard, your Sales 
Offline changes will not be applied to the Oracle Sales Online server. If 
you discard the conflicts you do not need to perform a synchronization. 

5. From the main Conflict Resolution screen you can select groups of 
conflicted records to Reapply or Discard. Select the checkbox by the 
record(s) you want to reapply or discard. If you want to reapply your 
changes to the server, click Reapply. If you want to discard the conflict, 
click Discard.

7 Tasks
Use the Tasks tab to view, create and edit tasks. Tasks are your day-to-day 
activities related to customers, leads, and other sales-cycle events. Also, the 
Calendar button enables you to access a Daily Task summary, which lists 
your tasks occurring between specified start and end dates. 

The Task tab displays all of your tasks, or tasks that have been assigned to 
you. These task details are displayed:

� Task number (hyperlinks to Task Details screen)

� Task name

� Start date and end date

� Task type

� Status

� Category

� Priority

� Source

� Source Name (hyperlink to further information about the named 
source)

Tasks can be sorted by time or date, in ascending or descending order.
 6 



7.1 Creating a Task
To create a task:

1. In the Task tab, click Create. 

The Create Task form opens. 

You can also create tasks directly from the source object. Navigate to the 
source object, open the details user form, and click the Task tab in the 
details form. Click Create while in the task tab to create a new task for 
that source object.

2. Select a task type for the task. 

3. Enter a task name and the appropriate required data. 

4. Complete any other optional fields and click Create to create a task. 

7.2 Customer Frame in the Task Details User Form
If you create a new task from the Task summary sheet, the Customer frame 
will not automatically populate information. You may add an existing 
Organization (party) or Contact (relationship) to the Customer frame. In the 
type menu select either Organization (party) or Contact (relationship). In 
the Name field, place in the appropriate Organization or Contact and click 
Go. Select the item you wish to add from the list of values. Certain 
information, if applicable, will populate in the other fields of the Customer 
frame depending on the item you selected. 

If you create a task from a source, i.e., Organization or Opportunity, the 
Customer frame will automatically populate certain information. For 
example, if you create a new task from the Organization user form (using 
Create Task in the Task tab of the Organization user form), the Organization 
name and associated information, if applicable, will automatically populate 
into the Customer frame. 

If you create a task from a lead, opportunity or quote, the Customer frame 
will automatically populate the Party (for example, Organization) and 
associated information, if applicable, into the Customer frame

7.3 References Tab in the Task Details User From
The references tab in the Task detail user form allows you to add reference 
information to the Task. You may add additional Organization, 
Opportunity, Lead or Quote information to the existing Task. Highlight the 
appropriate reference from the Reference Type menu, and place in the 
appropriate Organization, Opportunity, Lead or Quote name and click Go. 
Select the item you wish to add from the list of values. 
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You may also remove any reference rows by selecting the associated remove 
checkbox and clicking Save or Apply. 

7.4 Assignments Tab in the Task Details User From
The assignments tab in the Task detail user form allows you to add 
assignee's to a particular task. You may add additional persons to assign the 
task. In the Assignments tab of the Task detail user from, click the add an 
assignment menu, select the person to assign the task, and click Add.

You may also remove an assignment rows (except the "owner" row) by 
selecting the associated remove checkbox and clicking Save or Apply.

7.5 Contacts Tab in the Task Details User From
The contacts tab in the Task detail user form allows you to add Contacts to 
a task. In the Contacts tab of the Task detail user from, place in the contacts 
name you wish to add, click Go, and select the contact from the list of 
values. In order to select the primary contact for a Task, highlight and select 
the primary radio button next to the contact you wish to mark as primary. 

Note: The References tab in Sales Offline will not automatically 
populate reference rows. Upon syncing the newly created task, the 
reference rows will automatically be created in the online sales 
application, and the appropriate reference rows will be 
synchronized to the Sales Offline task record. You may add 
additional rows in Sales Offline if you choose to do so.

Note: The Assignments tab in Sales Offline will not automatically 
populate any assignment rows. Upon syncing the newly created 
task, the assignments "owner" row will be automatically created in 
the online sales application, and the "owner" row will be 
synchronized to the Sales Offline task record. The "owner" of the 
task will be the Sales Offline user who created the task. You may 
add additional assignee rows in Sales Offline if you choose to do so.
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You may remove any contact rows by selecting the associated remove 
checkbox and clicking Save or Apply. 

7.6 Updating a Task
To update an existing task:

1. In the Task tab, click the task number. The Task Details form opens. 

2. Complete any appropriate updates. 

3. Click Apply to apply changes as you continue to make changes, or click 
Save when you have completed your changes.

7.7 Accessing the Daily Task Summary
Click Calendar to access a Daily Task Summary. This summary displays all 
of the tasks that have a start date of a specified day, or within a date range. 
The task summary displays this task information:

� Task name

� Status

� Start date and end date

8 Lead
Use the Lead tab to view and manage leads. Leads are intended to capture 
the initial contact with potential customers, gathering information to 
indicate to a sales organization whether or not there is sufficient interest on 
the part of the buyer. When a lead is entered into the system, it can be 
ranked and assigned to the appropriate sales resource.

Note: The contacts (party relationships) available in the Contacts 
tab of the Task details form is dependent upon the information in 
the Customer Frame of the Task details tab. Only contacts 
associated (i.e. which have relationships to the Organization) with 
the Organization in the Customer Frame will be available to choose 
form in the Contacts tab. 

Note: Sales Offline supports a pop-up date chooser for the Task 
Module. In order for the date chooser to work properly, you must 
install the file Microsoft Windows Common Controls-2 6.0 
(Mscomct2.ocx). This file may already be installed on your 
computer. Contact your system administrator for assistance. 
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Once enough key information has been gathered, a lead can be qualified by 
a sales representative.

Leads can be generated through different sources:

� Marketing campaigns and trade shows can generate leads that can be 
imported into the system through the Lead Import process.

� TeleSales agents record lead information from phone calls into the 
system.

� Field Sales representatives record lead information from the field into a 
sales application.

You can perform the following functions from the lead tab:

� Create leads

� Update leads, which includes maintaining:

� Contacts

� Sales Teams

� Purchase Items

� Notes

8.1 Creating a Lead
To create a lead:

1. In the Lead tab, click Create.

The Create Lead form opens. Certain fields will automatically populate 
based on data and profile preferences established in your Online Sales 
applications.

Select the appropriate customer from the customer menu. If the 
customer does not exist, click New to create a new customer. See 
Customer for details on creating a new customer. 

Select an address by clicking Add or Change next to the address field. 
A list of customer addresses displays in the Select an Address form. 
Click the radio button next to the appropriate address and click Select.

2. Enter a lead name and the appropriate required data.

Note: There is Flexfield support for the Lead module. If Flexfield 
functionality has been implemented for a lead, the Flexfield name, 
field, and Flexfield will appear in the appropriate user form section.
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3. Click the Purchase Items tab to add purchase items as needed, 
specifying Product Category, quantity, amount, and source name. You 
can add one or multiple purchase items. Click Save to add the items. 

4. Complete any other optional fields and click Save to create a lead.

5. Click the Notes tab to add notes to the lead.

If needed, click Cancel to cancel creation of the lead.

8.2 Updating a Lead
To update an existing lead:

1. In the Lead tab, click the name of the lead. The Lead Details form 
opens.

2. Complete any appropriate updates.

3. Click the Contacts tab to add new contacts as needed. Only contacts 
associated with the header organization are available.

4. Click the Sales Team tab to add or remove sales team members.

5. Click the Notes tab to add notes to the lead.

6. Click Save when you have completed your changes. 

If needed, click Cancel to cancel update of the lead.

9 Opportunity
An opportunity is a potential sale. This process begins with the initial 
customer contact and ends when the sales representative makes or loses the 
sale.

You can perform the following functions from the opportunity tab:

� Create opportunities

� Update opportunities, which includes maintaining:

� Purchase Items

� Contacts

� Win/Loss

� Sales Team

� Notes

Once opportunities are identified, you can perform the following tasks:

� Identify how the opportunity came about
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� Enter information on items to be purchased

� Track the likelihood of closing the sale

� Allocate credit toward sales quotas after closing a sale

� Create a quote from the opportunity

Sales representatives can manage existing opportunities, assigned to them 
manually or automatically through Territory Assignment, or they can enter 
new opportunities. 

By default, the sales representative who created the opportunity has full 
access to the opportunity. Full access to the opportunity means that the 
sales representative who created the opportunity can add other sales team 
members, assign sales credits, and rate the likelihood that the opportunity 
will succeed.

9.1 Creating an Opportunity
Complete the following steps to create an opportunity:

1. In the Opportunity tab, click Create.

The Create Opportunity form opens.

Select the appropriate customer from the customer menu. If the 
customer does not exist, click New to create a new customer. See 
Customer for details on creating a new customer. 

Select an address by clicking Add or Change next to the address field. 
A list of customer addresses displays in the Select an Address form. 
Click the radio button next to the appropriate address and click Select.

2. Enter an opportunity name and the appropriate required data.

3. Complete any other optional fields. 

4. Click the Purchase Items tab to add purchase items as needed. You 
must specify the product category. Enter the quantity and amount 
where necessary.

5. Click the Notes tab to add notes to the opportunity.

If needed, click Cancel to cancel creation of the opportunity.

Note: There is Flexfield support for the Opportunity module. If 
Flexfield functionality has been implemented for an opportunity, 
the Flexfield name, field, and Flexfield button will appear in the 
appropriate user form section.
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9.2 Updating an Opportunity
To update an existing opportunity:

1. In the Opportunity tab, click the name of the opportunity. The 
Opportunity Detail form opens.

2. Complete any appropriate changes. 

3. Click the Purchase Items tab to add purchase items as needed. You 
must specify the product category. 

In order to view or edit the Opportunity Sales Credits, click Split. Add 
or edit the appropriate sales credit items.

4. Click the Contacts tab to add or remove contacts as needed. Only 
contacts associated with the header organization are available.

5. Click the Win/Loss tab to close an opportunity with the appropriate 
status. 

6. Click the Sales Team tab to add or remove sales team members.

7. Click the Notes tab to add notes to the opportunity.

8. Click Save when you have completed your changes.

9. Click Create Quote to flow the opportunity information into a new 
quote. A new quote can be created based on certain information carried 
over from an existing opportunity. Only purchase item rows with a 
specified inventory item numbers will be carried over to the new quote.

If needed, click Cancel to cancel the update of an opportunity.

9.3 Opportunity to Quote Business Flow
To create a quote from an opportunity:

In the Opportunity user form, click Create Quote. 

Certain information will flow from the opportunity to the new quote. The 
opportunity information that will go into the new quote (provided the 
information exists in the opportunity) is:

� Opportunity Name

� Customer Name

� Address

� Sales Channel

� Opportunity Purchase Items (if they have specific inventory items on 
the purchase item line)
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10 Quote
A quote is the communication of pricing and discounts for a particular sale. 
When the customer is ready to order a particular product they are notified 
of this available pricing and discount information through a quote. 

You can perform the following functions from the quote tab:

� Create quotes

� Update quotes, which includes maintaining:

� Lines

� Addresses

� Sales Teams

� Sales Credits

� Notes

10.1 Creating a Quote
To create a quote:

1. In the Quote tab, click Create.

The Create Quote form opens.

2. Enter a quote name.

Note: In the 11i9 release, you may not change the Quote Name 
(carried over from the Opportunity in the Opportunity to Quote 
business flow) nor the Quantity amounts. These items may be 
changed after a successful synchronization has occurred. 

Note: You must select specific items from the Profile: Sync 
Preferences: Quote Tab to be used in the quoting module Only 
those items downloaded to Sales Offline can be used to add new 
products to the quote.

Note: There is Flexfield support for the quote module. If Flexfield 
functionality has been implemented for a quote, the Flexfield name, 
field, and Flexfield button will appear in the appropriate user form 
section.
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3. Enter a customer. Place the appropriate customer name in the customer 
field and click Go. The list of customers will display. You can select a 
customer from this list, or search for another customer. 

4. Enter a contact. Enter the appropriate contact name in the contact fields 
and click Go. The list of contacts will display. You can select a contact, 
or search for another contact. 

5. Complete the other required fields and any appropriate optional fields 
and click Save or Apply to create a quote.

6. Click the Lines tab to add product lines. Click Add New Product to 
search and select products for the quote.

7. Click the Addresses tab to add shipping and billing addresses, and 
manage payment terms.

8. Click the Sales Team tab to add new members to the sales team.

9. Click the Sales Credits tab to give credits for the appropriate sales 
representative.

10. Click the Notes tab to add notes to the quote.

11. Click Apply to commit changes and calculate values. You can modify 
values and then click Apply to recalculate values dynamically.

12. Click Save when you have completed your changes.

If needed, click Cancel to cancel the creation of the quote.

10.2 Updating a Quote
To update an existing quote:

1. In the quote tab, click the name of the quote. The Quote Details form 
opens.

2. In the Main Details tab, complete any appropriate changes. 

3. Click the Lines tab to add or remove product lines.

4. Click the Addresses tab to add shipping and billing addresses, and 
manage payment terms.

5. Click the Sales Team tab to add or remove sales team members.

6. Click the Sales Credits tab to give credits for the appropriate sales 
group.

7. Click the Notes tab to add notes to the quote.

8. Click Apply to commit changes and calculate values. You can modify 
values and then click Apply to recalculate values dynamically.
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9. Click Save when you have completed your changes.

If needed, click Cancel to cancel the update of the quote.

10.3 Quote Approvals
If you have approvals established for the Quoting application, the Initiate 
Approvals button will appear in the Approvals tab of the Quote details user 
form. If the status transition is to get an Approval, the user can hit the 
Initiate Approvals button for the approvals process to take place. The Quote 
must be synchronized for the approvals process to begin. No approval rows 
will be displayed in the Approvals tab of the Sales Offline, Quote details 
user form. 

10.4 Place Order
The Place Order button will highlight on the Sales Offline, Quote Details 
user form if the Place Order status transition is established in the Quoting 
application. 

11 Forecast 
Forecasting is a quantitative tool used to predict the amount of sales for a 
specified time period. Forecasting can be used by managers and sales team 
members to commit to the amount of sales that they will close by the end of 
the forecasting period. You can forecast at two levels:

� Product Category: Forecasting at the Product Category level provides 
sales team members with an easy way to forecast their sales at the 
product level by rolling up opportunity lines into product groupings.

� Opportunity: Forecasting at the Opportunity level provides a tool for 
sales team members to create their own view and commitment of the 
opportunities that they or their sales representatives are working on. 

Perform the following functions from the Forecast tab:

� Generate forecasts and submit forecasts

� View opportunity level worksheets

� View product category worksheets

� View generate forecast values
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11.1 Opportunity Worksheet
Opportunity Level Forecasting provides a tool for sales team members to 
view their opportunities being forecasted. Worksheets are submitted with 
the generated forecasts chosen for submission.

To view opportunity worksheets:

1. From the Forecast tab, click the Opportunity subtab.

The Opportunity Worksheet page opens.

2. From the drop down list select the Sales Group, for which you want to 
view forecast.

3. Select the Period Name from the drop down list.

4. The forecast numbers will reflect the opportunity forecast data available 
in Sales Offline.

Pipeline defaults use the following criteria:

� Worst Case: Total Won Amount = Sum of all won opportunities

� Forecast: Weighted pipeline = Weighted sum of open opportunity 
amount multiplied by their win probability

� Best Case: Total sum of all forecast opportunities

5. You can edit the forecast values by highlighting the Best Case, Forecast, 
or Worst Case cell and adding in the value.

6. Click Save to save your Opportunity worksheet.

11.2 Product Category Worksheet
Forecasting at Product Category level gives sales team members an easy 
way to view their pipeline aggregated into product groupings. Worksheets 
are submitted with the generated forecasts chosen for submission.

Viewing Product Level Forecasts Using Product Category Worksheets

To view product level forecasts using product category worksheets:

1. From the Forecast tab, click the Product Category subtab.

The Product Category Worksheet page opens.

2. From the drop down list select the Sales Group, for which you want to 
forecast.

3. Select the Period Name from the drop down list.

4. The forecast numbers will reflect the opportunity forecast data available 
in Sales Offline.
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5. You can edit the forecast values by highlighting the Best Case, Forecast, 
or Worst Case cell and adding in the value.

Pipeline defaults use the following criteria:

� Worst Case: Total Won Amount = Sum of all won opportunities

� Forecast: Weighted pipeline = Weighted sum of open opportunity 
amount multiplied by their win probability

� Best Case: Total sum of all open opportunities

6. Click Save to save your Product Category worksheet.

11.3 Generating Forecasts
Under the Forecast tab, you will find the Generate Forecast subtab. Sales 
representatives can generate individual forecasts for multiple periods from 
this page. Forecasts are generated based on their current downloaded 
pipeline values. Users can forecast based on their default currency.

To generate a forecast:

1. From the Sales Group section, select a sales group from the drop down 
list.

2. From the Forecast section, select the Period Type from the drop down 
list.

3. Select the “From Period” and “To Period” from the drop down lists.

4. Select the Forecast Category from the drop down list.

5. Click View.

6. Displays the values that will be generated for your forecast.

7. Select all periods for which you want to generate forecasts by selecting 
the check box.

8. Click Submit.

The forecast is now ready to be submitted when you synchronize. Only the 
most recent submission is accepted. You can not submit more than one 
forecast per synchronization. 

11.4 View and Submit Forecasts
To view Forecasts:

1. From the Forecast tab, click the Forecast subtab.

2. Select the Sales Group from the drop-down list.
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3. Select the Period Name from the drop down list.

4. The forecast numbers will reflect the opportunity forecast data available 
in Sales Offline.

5. You can edit the forecast values by highlighting the Best Case, Forecast, 
or Worst Case cell and adding in the value.

6. Click Submit. 

The forecast is now ready to be submitted when you synchronize. Only 
the most recent submission is accepted. You can not submit more than 
one forecast per synchronization.

12 Customer 
The Customer tab is comprised of two subtabs, Organization and Contact. 
By default, the Customer tab opens to the Organization page. Click the 
Contact subtab to open the Contact page. 

Use the Customer tab to create and maintain the following:

� Organizations

� Contacts

12.1 Organization Subtab
From the Organization subtab, you can perform the following functions:

� Create organizations

� Maintain organization details

� Create and maintain notes

� Create and maintain sales team members

� Create and maintain address details

12.1.1 Creating a Customer - Organization 
To create an organization:

1.  In the Customer tab, Organization subtab, click Create. The Create 
Organization form opens. 

Note: There is Flexfield support for the customer module. If 
Flexfield functionality has been implemented for an organization or 
contact, the Flexfield name, field, and Flexfield button will appear 
in the appropriate user form section.
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2. Enter the organization name and any other required fields in the Main 
Details form. 

3. Optionally, complete any non-required fields.

4. Click the Addresses tab to manage addresses for the organization.

5. Click Create Address to add a new address. Enter the required fields 
(an address type) and click Save to save the address information. 

6. Click the Notes tab to add notes to the customer information. 

7. Click Save to create a new organization.

If needed, click Cancel to cancel the customer information.

12.1.2 Updating a Customer - Organization 
To update information for an organization:

1. In the Customer tab, Organization subtab, click the name of the 
organization.

2. The Organization Detail form opens.

3. Complete any appropriate changes.

4. Click the Addresses tab to manage addresses for the organization. 

5. Click Create Address to add a new address. Enter the required fields 
(an address type) and click Save to save the address information. 

To edit an existing address, click the address hyperlink. Complete any 
appropriate changes and click Save to save your changes, or click 
Cancel to cancel the update.

6. Click the Sales Team tab to add new members to the sales team.

7. Click the Notes tab to add notes to the customer information. 

8. Click Save to commit your changes.

If needed, click Cancel to cancel the update of the customer 
information.

12.2 Contact Subtab
You can use the Contact subtab to perform the following tasks:

� Create a contact

� Maintain contact details

� Add and maintain contact address information

� Create and maintain notes
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12.2.1 Creating a Customer - Contact 
To create a contact:

1. In the Customer tab, Contact subtab, click Create.

The Create Contact form opens.

2. Select a Contact. You can select an existing contact from the list of 
contact names in the Contact Name drop-down menu, or specify a new 
Contact name by clicking New. 

To create a new contact, click New, and then enter the contact’s name 
and other required fields. Click Create to create the new contact. The 
newly created contact is now available for you to add to an existing 
organization. 

3. Select Organization.

If the organization is new, click New next to the organization field to 
create new organization. Refer to "Organization Subtab" for details on 
creating an organization. 

4. Select a relationship type in the Relationship Details section.

5. Complete any appropriate optional fields. 

6. Click Add an Address in the Addresses tab to add new addresses for 
the contact. A list of addresses associated with the organization will 
appear. Choose an address and click Select. 

7. Click the Notes tab to add notes to the contact. 

8. Click Save to create a new contact.

If needed, click Cancel to cancel the creation of the contact. 

12.2.2 Updating a Customer - Contact
To update information for a contact:

1. In the Customer Tab, Contact subtab, click a contact name. The Contact 
detail form opens.

2. Complete any appropriate optional fields. 

3. Click the Addresses tab to add new addresses for the contact.

4. Click the Notes tab to add notes to the contact. 

5. Click Save to commit your changes.

If needed, click Cancel to cancel the update of the contact.
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13 Implementing Sales Offline
This section is meant for the DBA or the technical administrator. 

13.1 System Administration Tasks
To implement Sales Offline:

1. Ensure that the customer has fully implemented Oracle Sales Online.

2. Ensure that the customer has licensed Oracle Mobile Field Sales Laptop 
(ASL) and applied Sales Offline patches using ADpatch.

3. After applying the patches, clear the Jserv cache.

4. If implementing Flexfields, refer to Section 13.4. 

5. Restart the application server.

13.2 Configuring Tab Display
Use the ASL_XLS_MAIN_MENU file to control the display of tabs in Sales 
Offline. This step is only necessary if you want to customize the tab display 
in Sales Offline.

1. Using System Administrator responsibility, launch the Menus form and 
navigate to the ASL_XLS_MAIN_MENU menu.

2. Edit the tab display as desired.

� To change the label of a tab, edit the Prompt field of the 
corresponding menu entry.

� To change the order of tabs, recreate the menu entries with the 
correct sequence (determined by the Seq field).

� To remove a tab, clear out the Prompt field of the corresponding 
menu entry.

� To customize the subtabs, refer to the Submenu name under the 
parent menu and find that menu. Then modify as described for 
tabs. For example, to customize the subtabs under the Home tab, 
find the menu ASL_XLS_HOME and edit its menu entries.

Note: ASL_XLS_MAIN_MENU and its submenus are not 
associated with any existing responsibility. As a result, changes to 
these menus affect all Sales Offline users. Menu and function 
exclusion defined at Responsibility level are not considered when 
rendering tabs in Sales Offline. An exception is the ASL_EXCEL_
MENU menu, which is used for the Mobile tab (accessible from 
Oracle Sales Online).
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13.3 Setting System Profile Options for Sales Offline
This section describes the system profile options used by Sales Offline. The 
procedure for setting and changing system profile options is the same for 
all Oracle applications. For a detailed description of the procedures, refer to 
the Oracle Applications System Administrator’s Guide. 

The profiles described are:

� General System Profiles

� User Preference Profiles

� Sync Time Profile

� Field Sales/Laptop Profiles

� Downloaded Online Application Profiles

� Quote Profiles

� Forecasting Profiles

13.3.1 General System Profiles
These are the system profile options you can set:

� ASL: Campaign Code Download Threshold - Determines the number of 
campaign (source/offer) codes to download.

� ASL: Excel Debug - if set to Yes, debug option is turned on and the 
application will create logs on the server. The log file will be created in 
a directory of the middle tier. The location of that directory is specified 
by the Jserv parameter "service.Logging.common.filename". The format 
of the file name is ASL_[username]_[sessionname].log.

� ASL: Download Service Items - set profile to N if you do not implement 
the Service Contract module.

13.3.2 User Preference Profiles
These profiles are used for storing user's preference specified in Sync 
Preferences UI. No setup is required. Do not attempt to manually change 
these values.

� ASL: Excel Budget Status

� ASL: Excel Customer Category

� ASL: Excel End Period

� ASL: Excel Forecast Category

� ASL: Excel Forecast Credit
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� ASL: Excel From Win Probability

� ASL: Excel Lead Channel

� ASL: Excel Lead Max

� ASL: Excel Lead Rank

� ASL: Excel Lead Status

� ASL: Excel Opportunity Status

� ASL: Excel Organization Country

� ASL: Excel Organization State

� ASL: Excel Period Type

� ASL: Excel Sales Channel

� ASL: Excel Sales Stage ID

� ASL: Excel Start Period

� ASL: Excel Timeframe

� ASL: Excel To Win Probability

13.3.3 Sync Time Profile 
This system profile option is used for storing user's last sync time. Please do 
not change.

�  ASL_EXCEL_LAST_SYNC_TIME

13.3.4 Field Sales/Laptop Profiles
These system profile options are used in Field Sales/Laptop. They are 
obsolete, and not required for use in Sales Offline. They are listed here for 
your information:

� ASL: ACCESS_CALLOUTS

� ASL: Conflict Flag

� ASL: Default MTL Organization ID for Field Sales/Laptop

� ASL: Enable Attachment

� ASL: Enable Configurator

� ASL: Enable Encyclopedia

� ASL: Enable Selective Download

� ASL_WRAPPER_DEBUG
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13.3.5 Downloaded Online Application Profiles 
Sales Offline will download and use these profiles if they are established in 
the online applications. Refer to the appropriate online application 
implementation guide for further details on these profiles: 

� ASO: Default Currency Code

� ASO: Default Order Type

� ASO: Default Ordered Quantity in OC UI

� ASO: Default Quote Status

� ASO: Default Sales Channel

� ASO: Quote Duration

� ASO: Validate Salesrep

� BNE Servlet Path (see section 13.4 for more details)

� IES: Organization Id

� OS: Address Required for Opportunity

� OS: Address Required for Organization

� OS: Address Required for Person

� OS: Address Required for Sales Lead

� OS: Decision time frame required

� OS: Default Budget Status for Leads

� OS: Default Channel for Leads

� OS: Default Close Date Days

� OS: Default Decision Timeframe for Leads

� OS: Default Lead Contact Role

� OS: Default Opportunity Sales Stage

� OS: Default Opportunity Status

� OS: Default Opportunity Win Probability

� OS: Default Sales Channel

� OS: Forecast Sales Credit Type

� OS: Opportunity Probability Link

� OS: Sales Methodology

� OS: Source Code Mandatory for Leads
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� OS: Source Code Required for Opportunity

� OSO: Default Country

� OSO: Default Forecast Currency

� OSO: Forecast Max Generate Months

13.3.6 Quote Profiles
These Quote profiles are supported:

� JTF_PROFILE_DEFAULT_CURRENCY

� ASO: Enable Approvals

� ASO: Allow Skip Approvers

� ASO: Default Currency Code

� ASO: Default Ordered Qty in OC UI

� ASO: Default Quote Status

� ASO: Default Sales Channel

� ASO: Enable Line Flexfields in HTML UI

� ASO: Default Order Type

� ASO: Quote Duration

� ASO: Enable Security Check

� ASO: Enable Submit Button

� ASO: Status Override

� ASO: Validate Salesrep

13.3.7 Forecasting Profiles
If you are implementing Forecasting for the 11.5.8 or 11.5.9 release, use 
these profiles:

� OSO: Allow Opportunity Forecast By Product Category = No

� OSO: Enable Opportunity Worksheet Threshold = No

� OSO: Opportunity Worksheet Threshold Amount = Empty

13.4 Descriptive Flexfield Support
Sales Offline leverages several flexfield application setups from Oracle 
Sales, Oracle Order Capture, and Oracle Receivables.
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If you implement Descriptive Flexfields for the online applications and use 
them in Sales Offline you must set the this profile:

BNE Servlet Path = the servlet path that Servlet Engine specifies 

(this path should be specified in zone properties file in Apache 
configuration).

13.4.1 Sales Offline Opportunity and Lead Flexfields
These opportunity and lead flexfields are supported by Sales Offline:

� Application: Oracle Sales

� Title: Opportunities

� Title: Sales Leads

� Title: Opportunity Lines

� Title: Sales Lead Lines

13.4.2 Sales Offline Organization and Contact Flexfields
These customer organization flexfields are supported by Sales Offline:

� Application: Oracle Receivables

� Title: Party Information

� Title: Organization Contact Information

13.4.3 Sales Offline Quoting Flexfields
These quoting flexfields are supported by Sales Offline:

� Application: Oracle Order Capture

� Title: Header: Additional Information

� Title: Lines: Additional information

13.4.4 Sales Offline Task Flexfields
This task flexfield is supported by Sales Offline:

� Application: CRM Foundation

� Title: Tasks additional information
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